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PENNSYLVANIA TURNPIKE COMMISSION 

USER’S MANUAL FOR  
CUSTOMIZED ARCVIEW APPLICATIONS 

 
Introduction 

 
 
The following manual has been provided to explain the custom functions that have been 
created by W.E.C. Engineers as an enhancement of ArcView GIS software. It is assumed that 
the user of this program has had previous experience with ArcView and is familiar with the 
program; therefore, comprehensive ArcView user instruction is not provided.  For any 
information concerning ArcView 3.0 or 3.1, please consult the ArcView 3.0 or 3.1 user 
manual. 
 
 
This manual is the general manual for all custom ArcView projects.  Most of the information 
provided applies to all of the projects, with a few exceptions that apply only to the OverView 
project.  The functions that apply only to the OverView project will not be available or 
visible within the other projects, and these distinctions will be noted.    
 

Opening a Project 
 
There are two ways to get to the individual projects.  The first way is to double-click on the 
ArcView shortcut icon on the desktop and then select the desired project from the File-open 
menu.  There are four projects: Beaver Valley Extension, Greensburg Extension, Mon-
Fayette Extension, and the Turnpike Mainline. 
 
The other way is to double-click on the project file in Windows Explorer.  All of the 
ArcView projects are found in the AVProj subdirectory.  Navigate to the following path 
using Windows Explorer:  I:/GIS/DATA/AVProj.  Double-click on one of the apr files to 
start ArcView and open the project. 
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The Program Window 
 
For example, if you open the Beaver Valley Extension project (“beaver.apr”), you will see a 
screen such as the one below.  The key elements of the window have been labeled for easy 
identification. 
 

Table of 
Contents for 
Map Layers

(Themes) 

Button Bar

Tool Bar

View Menu  
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Section 1: Functionality of Tools, Buttons and View Menu 
 

Theme Sorter 
This button is visible in the View graphical user interface (GUI) for all projects.  The 
purpose of this button is to give the user the ability to sort a View’s Table of Contents 

based on feature type.  For example, if the feature type is a line and is represented spatially as 
such, using this button will move and group all other line features.  The same holds true for 
polygons and points.  All point themes are placed at the top of the Table of Contents and 
polygon themes are placed at the bottom of the list.  ArcView draws the themes from bottom 
to top.   

After Before 

 

Theme Transporter 
Visible in the View GUI for all projects, this button allows the user to move the active 
theme up in the Table of Contents.  When more than one theme is selected, this 

function only moves the top theme.  If the theme is at the top of the Table of Contents and 
this function is used; the theme will be moved to the bottom of the table.  Holding the shift 
key down when using this button moves the theme down once in the Table of Contents.  
Clicking on a theme name, holding down the mouse button and dragging the theme to the 
desired position in the Table of Contents will also move the theme to the desired position.   

Before After 
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Annotation Button 
This button, usable in all programs, toggles all annotation on and off in the view GUI.  
This function turns on all ARC/INFO annotation coverage’s in the view (the check 

box indicates that the theme is visible).  This displays the annotation text in the view.  To 
undo this labeling, click the annotation button again.   

Before After 
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Engineering Drawing Features Button 
Visible in all projects except the OverView project this function works just like the 
annotation button.  This enables the user to toggle the display of the engineering 

drawing features and text. 
 
 

 

Hot Link Tools 
This function enables the user to see any sketches or photographs that are linked to a 
feature in the view.  It is available in all of the projects except the OverView project.  

The theme that would contain the sketch or photo, such as the monument or signs theme, 
must be active for the hot links button to be enabled.  The user must select the Hot Link tool 
and then click on a feature displayed in the active theme.  If there is no picture available the 
message below is displayed. 
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Refresh Button 
Visible in all projects, this function forces the display to redraw itself.  There are three 
ways to perform this function.  The first is by using the button to the left.  The second 

is by selecting the Refresh menu item from the View menu as shown below. 
 

 
 
The third way is to press “Ctrl” and “R” at the same time on the keyboard. 
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Area Zoom Tool 
This function is only accessible in the OverView project.  This button allows the user 
to select an area in one view and then zoom into this area in another view.  For 

example, there may be an area of particular interest in the Beaver Valley Extension View and 
you want to see it in the Pennsylvania Turnpike View.  Use the following steps to use the 
Area Zoom function: 
 

1) Click on the Area Zoom tool. 
 
2) Make the Beaver Valley View the active document window by clicking anywhere on 

the view document. 
 
3) Draw a rectangle around the area of interest by clicking the mouse at one corner of 

the area, holding down the mouse button while moving your mouse to the opposite 
corner of the area and then releasing the mouse button.  (Figure 1) 

 
4) Make the second view (the Pennsylvania Turnpike View) the active document 

window.  (Figure 2) 
 
5) Move your mouse cursor to the map area of the View and click the mouse button. 
 
6) The mouse click prompts ArcView to redraw the Pennsylvania Turnpike View to 

show the area of interest selected in the first view (the Beaver Valley View).  
(Figure 3) 

  
Figure 1 Figure 2 

Figure 3 

8 



Customized ArcView Applications User's Manual  Section 1 
 

Tile Views 
This command takes the four views (Beaver Valley Extension, 
MonFayette Extension, Green Extension, Pennsylvania 
Turnpike) and tiles them in the Arcview program window, as 
shown below.  This function is only available in the Overview 
project.  

 
 
 
 
The Window Menu of the OverView project view documents contain two additional custom 
functions: Custom Tile and Save Tile. 
 
The Custom Tile function allows the user to choose a tiling that has been previously 
customized to their preferences, and saved with the Save Tile function.  After choosing 
Custom Tile, a general dialog box appears and lets the user find and select the desired 
custom tiling. 

 
 

9 



Customized ArcView Applications User's Manual  Section 1 
 

The Save Tile function acts like any other save function.  Once the tiling is customized to the 
user’s satisfaction, choose the save tile command.  Type a distinctive file name in the upper 
left input box of the Custom Tile File dialog box.  Note the path and folder name where the 
new file will be stored and then click the OK button. 
 

 

Table of Contents Toggle 
This option gives the user the ability to toggle the Table of Contents 
off and on in an active view.  There are two ways to do this.  The 
user can go into the View menu and scroll down to Toggle TOC, or 
press F8 on the keyboard.   

After Before 

 
 
 

Toggle Between Windows 
This function is only availiable in the OverView program.  To 
toggle the active window from view to view between the four 
different windows go to the View menu and scroll down to the 
Next Window command.  The shortcut to this feature is to press 
the F12 button on your keyboard. 
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Section 2:  Viewing Record Information from the Database 
 

Using the Feature ID Tool 
There are several ways to get information from the databases.  The first way is to use 
the red diamond tool.   

 
Click on the tool button and then select a point on the map by clicking on the feature.  
Selecting a point along the centerline will allow you to view the database features associated 
with the centerline.  If your selection is on a bridge, you will also have the option to view the 
bridge log features. 

 
A Feature ID dialog box appears which indicates what kind of database information is 
available for the point you clicked:  Bridges, Centerline, Municipalities, or Counties.  After 
you select the feature to view, click the OK button. 

 
The result is a database form that contains milepost information and area information (e.g. 
municipality, county, etc.) for the selected point.  All the data for that point will be shown.  If 
the selection point happens to be on a bridge location, then the database form will show only 
the fields specified by the user.  (Setting up the bridge log for a specific user is explained in 
Section 4, pages 13 & 14.) 
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Using the Database Viewer Tool 
The V tool gives the user the option to page through the entire set of information in 
all the database files.  To use the V tool, first click on the button on the tool bar, and 
then click on the map display area with your cursor.  A Database Viewer dialog box 

appears which allows you to select the database you wish to browse:  Bridges, Centerline, 
Municipalities, or Counties.   
 
 
 
 
 
 
 
 
 
 
 
Your options are dependent on where you click the cursor on the map display.  For example, 
if you don’t click on a bridge, the bridges database doesn’t appear in the Database Viewer. 
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After making your selection, a Theme Database Viewer form appears which allows you to 
step through all the records in the selected database. 
 

 
Use the arrows on either side of the record numbers to move forward or backward in the 
database. The arrows on the outer edges allow you to jump to the first or last record. 

1  of  268 
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Using the Identify Tool 
The final way to get database information is by using ArcView’s standard identify 
tool. 
 

First, you must select the theme from which you would like to get information (click on the 
theme name, e.g. “Beaver Centerline” on the Table of Contents list to the left of the map).  
When you click on the name the theme will be highlighted (raised) on the Table of Contents 
to indicate that this is the current, active theme. 

 
 
Next, click the Identify tool and then click an area on the map for which you want 
information. 
 
An Identify Results form similar to the one below will appear showing you the information 
about the point you selected on the centerline. 
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Section 3:  Milepost Numbers 
Calculating the Number for a Point 

 

Using the Milepost Tool 
There are two ways to get a calculated milepost number for a location along the 
centerline.  The first method is to use the M tool. 
 

 
To calculate the correct milepost location for a selected point on the centerline, click the M 
tool and then click your mouse button with your pointer over the location on the map. 
A form appears which indicates the route and milepost for the selected location. 
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Using the I Tool 
Another way to find a milepost number is to use the I button on the tool bar. 
 
 

If you are using the Turnpike Mainline Project, the Route dialog box will ask you to input, 
which route you would like to use.  Type in your selection and then click OK.  (For all other 
programs, just click your mouse on the map after selecting the tool, as there will be no route 
dialog box to type in a selection.) 
 
 
 
 
 
 
 
 
Next, click your mouse button with your pointer on the point along the centerline where you 
want the milepost number.  The map display area will zoom to the area you have selected 
and place a temporary graphic and label for the selected milepost. 
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Section 4:  Using the Zoom Menu 
 
The Zoom Menu allows the user to select a particular feature and have the map display zoom 
to that area. You may zoom to any of the selected features in the menu items list.   
Examples of the features lists are given below. 

Menu Features 

 
 
If you select the Milepost item in the menu, a different dialog box will appear where you 
must specify the route and the range of mileposts you wish to see. 
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The result will be similar to the view shown below. 
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Section 5:  Using the Bridge Log Functions 
 

Changing User Settings 
In order to change the user specified settings for the bridge log; the user must make the 
project window active.  An easy way to do this when you are in a View document is to use 
the Window Menu, and select the APR file from the list as shown below. 
 

 
Once the project window is active, the user can specify functions from the Bridge Log Menu. 
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Importing a New Database File 
Import is used to bring in a new bridge log database file into the 
program.  The most current bridge log is automatically loaded when the 
project files are loaded.  However, there may be an occasion where the 
user might want to load a new bridge log. 
 
 
 

 

Specifying a New User and Deleting Users 
To specify a new user of the application, select the “New User” item.  
A dialog box will allow you to type the name of the new user.  “Delete 
User” will allow you to delete an existing user. 
 
 
 
 
 

Switching User Formats 
“Switch Format” allows you to change from one user’s format 
specifications to another user’s specifications. 
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Editing the Format 
To change your specifications, select “Edit Format”.  Select the user 
which requires changes to the Bridge Log Database View form.  Then 
click OK.   
 
 
 
 

 
 
 
 
 
 
 
 
A dialog box will appear which will allow you to place a check mark in front of all the fields 
you would like to see in the form.  There are four pages to the format selection form. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
When you have finished making your selections, close the dialog box (click on the X button 
on the top right-hand corner).  When the users selects to retrieve bridge information from the 
project files, only the fields that have been checked will be shown in the form.  Users should 
log-in using their own names and passwords; otherwise the forms will not display their own 
viewing specifications. 
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